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Warranty and License Agreement

Software License Agreement
This is a legal Agreement between you, the end user, and BARCO NV., a Belgian corporation 
(“BARCO NV”). By accepting this package, you agree to be bound by the terms of this Agreement. 
If you do not agree with the terms of this Agreement, return the unopened disk package and the 
accompanying manuals, containers, and hardware (“Product Materials”) to the person or place from 
which you obtained them for a full refund. Your product is a single user version unless your 
product’s packaging indicates otherwise, or unless you have a separate written Agreement with 
BARCO NV.
BARCO NV grants to you a nonexclusive license to install and use one copy of the software 
included in this package (“Software”) on a single terminal connected to a single computer. The 
Software is in “use” when it is loaded into temporary memory (i.e. RAM), or installed into 
permanent memory (i.e. hard disk, CD-ROM, or other storage device) of that computer. Installation 
on a computer that may be concurrently accessed by more than one user shall not constitute a 
permitted use and a separate license is required for each active user connected to a computer on 
which the Software is being used. If the Software package contains more than one type of disk (i.e. 
floppy and CD-ROM), then you may use only one set of the disks provided. You may not use the 
disks on another computer, or loan, rent, lease, or transfer them to another user except as part of the 
permanent transfer (as provided below) of all Software and Product Materials. You may only use the 
Software in conjunction with Software licenses by BARCO NV.

Copyright
The Software is owned by BARCO NV and is protected by international copyright laws, 
international treaty provisions, and all other applicable laws. Therefore, you must treat the Software 
like you would any other copyrighted material (i.e. a book or musical recording), except that you 
may either make one copy of the Software solely for backup or archival purposes, or transfer the 
Software to a single hard disk, provided you keep the original solely for backup or archival 
purposes. Any such backup automatically becomes property of BARCO NV and is subject to this 
Agreement. You may not copy the Product Materials without written permission.

Other Restrictions
You may not rent or lease the Software, but you may transfer the Software and Product Materials on 
a permanent basis provided you retain no copies, and the recipient agrees to the terms of this 
Agreement. You may not modify, reverse-engineer, decompile, or disassemble the Software. If the 
Software is an update, any transfer must include the update and all prior versions.

Term
This license is effective until terminated. You may terminate it at any time by destroying the 
Software and Product Materials in accordance with this Agreement together with all copies in any 
form. It will also terminate upon conditions set forth elsewhere in this license, or if you fail to 
comply with any term or condition of this license. You agree upon such termination to destroy the 
Software and Product Materials in accordance with this Agreement together with all copies in any 
form.



Limited Warranty
BARCO NV does not warrant that the Software will meet your requirements or that the operation of 
the Software will be uninterrupted or error-free. However, BARCO NV 
warrants that the Software will perform substantially in accordance with the accompanying Product 
Materials for a period of 90 days from the date of receipt of the Software, and the Software will be 
free from defects in materials and workmanship under normal use and service for a period of 90 
days from the date of receipt.

No Other Warranties
Except as expressly set forth herein, BARCO NV disclaims all other warranties, either express or 
implied, including but not limited to implied warranties of merchantability and fitness for a 
particular purpose, or warranty of non-infringement with respect to the Software and Product 
Materials. The entire risk as to the quality and performance of the Software is with you. This limited 
warranty gives you specific legal rights, and you may also have other rights which vary from state to 
state.

Remedies
BARCO NV’s entire liability and your exclusive remedy shall be, at BARCO NV’s option, either 
return of the price paid, or repair or replacement of the Software that does not meet BARCO NV’s 
Limited Warranty and which is returned to BARCO NV with a copy of your receipt. This Limited 
Warranty is void if failure of the Software has resulted from accident, abuse, or misapplication. Any 
replacement product will be warranted for the remainder of the original warranty period, or 30 days, 
whichever is longer. 

Limitation on Liability
In no event shall BARCO NV or its suppliers be liable for any damages whatsoever including, 
without limitation, damages for loss of business profits, business interruption, loss of business 
information, or other pecuniary loss or incidental or consequential damages, arising out of the use or 
inability to use the Software, even if BARCO NV has been advised of the possibility of such 
damages; or for any claim by any other party under any legal or equitable theory. In any case, 
BARCO NV’s entire liability under any provision of this Agreement shall be limited to the amount 
actually paid by you for the product.

Export
You acknowledge that the laws and regulations of the United States restrict the export and reexport 
of the Software. You agree that you will not export or reexport the Software in any form without 
first obtaining written approval from BARCO NV and the appropriate U.S. and foreign government 
approvals.

General
This Agreement is governed by the laws of Belgium. Failure or delay in enforcing any right or 
provision of this Agreement shall not be deemed a waiver of such provision or right with respect to 
any subsequent breach or a continuance of an existing breach. If any provision of this Agreement 
shall be held to be unenforceable, that provision will be enforced to the maximum extent possible, 
and the remaining provisions of this Agreement will remain in full force and effect. Should you 



have any questions concerning this Agreement, write to BARCO NV. Th. Sevenslaan 106, B-8500 
Kortrijk, Belgium.

Trademark information
MediCal, BarcoMed, and MeDis are registered trademarks of BARCO NV.
Windows NT, Windows 2000, Windows XP are registered trademarks of Microsoft Corporation.
The Java-based logos are registered trademarks of SUN Microsystems, Inc.

All other products and company names are trademarks of their respective owners.
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1 Introduction

1.1 About this manual
This manual describes how to install and use the MediCal® Pro software.

Some of the functions in MediCal Pro are accessible in Advanced user 
mode only. In the manual, these functions are indicated by this symbol:  

1.2 About MediCal® Pro
MediCal Pro is the complete tool for obtaining conformance (or 
conformity) and maintaining consistency on medical viewing stations. It is 
designed to set up schedules and perform automated checks for Quality 
Assurance (Q/A).

With MediCal Pro, you can set up and align the displays of the viewing 
station, including the definition of a display function and conformance 
calibration. You can set up a Q/A check schedule, consisting of different 
tasks that can be scheduled with a different frequency. You can verify the 
results of the Q/A tasks and get hints how to regain consistency, should a 
Q/A task turn out not to be OK.

Any necessary measures for regaining consistency can be taken from 
MediCal Pro or sometimes from MediCal Administrator, the server 
application to which MediCal Pro can be connected.

MediCal Pro distinguishes two user modes: The Standard user mode and 
the Advanced user mode.

The Standard user mode is meant for running the Q/A tasks and checking 
their results.

In Advanced mode, the user has full control over MediCal Pro, with the 
possibility to set up the system and change schedules and settings.

The Advanced user mode is secured by a password.

The Q/A check results are stored in a history log, which you can consult 
per task and per display.

If the viewing station is connected to a network on which the server 
application MediCal Administrator runs, all data from MediCal Pro is 
transferred to a database that can be consulted remotely by MediCal 
Administrator.
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MediCal Pro supports BARCO displays as well as displays from other 
brands. It allows the connection of the following optical sensors: Barco 
LCD sensor, Barco Serial sensor, X-Rite DTP92 (serial and USB), Wellhofer 
Luxor LXPlus, Solar PMA2200, Minolta LS100, Verilum CPOD (serial and 
USB) and Tektronix TJ17. Also the BARCO I-Guard sensor inside BARCO flat 
panel displays is supported.

1.3 About QA tasks
With MediCal Pro, you can set up a schedule of QA tasks that have to run 
at certain moments to check the conformance and consistency of the 
viewing station displays.

When MediCal Pro is installed, a number of standard tasks are available to 
be included in the QA schedule. A variety of other tasks is available as 
plug-ins.

The tasks can be categorized in three groups, depending on the impact 
they have on the user and the applications running on the viewing 
station.

The task categories are: 

Once the QA task schedule is completed, the tasks will be executed at the 
scheduled moments thanks to a service, MediCal Communicator, installed 
together with MediCal Pro.

However, you can also run the tasks manually at any time, when this 
would be necessary.

Transparent inter-
vention-free

The task runs completely in background. It does not 
require any action from the user and does not change 
the image on the display. E.g., an Automatic I-Guard 
Check on a BARCO Coronis display is such a task. 
These tasks can run also when no user is logged in on 
the workstation.

Intervention-free The task does not require any action from the user but 
does change the image on the display. E.g., the Mea-
sure Quality Level of a BARCO Coronis display runs 
completely automatic, but during the execution of the 
task, the current application image is replaced by test 
images necessary for the measurement.
These tasks can run only when a user is logged in on 
the workstation.

Non-intervention-
free

The task requires a user action. E.g., a visual check on 
a test pattern requires the user to confirm that the 
pattern was displayed correctly.
These tasks can run only when a user is logged in on 
the workstation.
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1.4 The main window at start-up
MediCal Pro always starts in Standard user mode.

In Standard user mode, the main window consists of the Q/A Check 
section, allowing you to run and check Q/A tasks.

The Q/A Check section in the main window contains the following items:

• Last Q/A check on: Here you find the date and time the last Q/A check 
was run. If no Q/A check was run yet (e.g., after installation), this will 
be listed as Unknown.

• Result: Here you find the evaluated result of the last Q/A check.

• Sometimes the Info symbol  is visible next to the result. When 
you move the mouse pointer over the symbol, a tooltip with more 
information pops up.

• The following results are possible:

• Today’s Q/A tasks: The number of Q/A tasks that are due for today 
and not have been executed yet.

• Q/A Check... button: Click to execute the due Q/A tasks immediately.

OK:  All Q/A tasks were OK, so the system is OK.

Not OK: At least one of the Q/A tasks failed. To see which task(s) 
failed, click on the Q/A Setup... button.

Skipped: The user decided not to run the Q/A check.

Unknown: At least one of the Q/A tasks has not been run yet or the 
configuration has changed since the last Q/A check.
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• Test Patterns... button: Click to open the Test Patterns dialog. From this 
dialog you can select to display test patterns.

• Q/A Setup... button: Click to open the Q/A Setup dialog. From this 
dialog you can see which tasks are scheduled. To modify the task 
schedule, you must log in as Advanced user.
As Standard user, you can also check the result of the individual Q/A 
tasks.

• View menu: Select the style you desire from the Select Style drop-
down list. The selected style applies to the height of texts, icons and 
windows.
To activate the selected style, exit MediCal Pro and open it again.

• Tools menu: As standard user, there is only one option: 
Options > User Login. Use this dialog to enter the Advanced user mode 
(see “Using MediCal Pro” on page 66).

• Help menu: Via this menu, you can consult the online help pages, 
send a feedback e-mail and view information about the application.

1.5 The main window in Advanced user mode
In Advanced user mode, the main window consists of the Q/A Check 
section and the Configuration section.
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The Q/A Check section is the same as described above.

The Configuration section in the main window gives an overview of the 
imaging boards and displays attached to the workstation. Moreover, it 
allows to setup or change the configuration and perform several actions 
to the displays in the configuration.

The Configuration section contains the following items:

• The number of rectangles in the Configuration section reflects the 
number of imaging board heads in the computer. 
E.g., if the computer contains one dual-head imaging board, you will 
notice two squares in the Configuration section: one for each head.

• For each display that you wish to control and check with MediCal Pro, a 
display icon should appear in the rectangles. 
These icons reflect the displays connected to the imaging board heads.

• If one or some of the displays you wish to control does not appear as 
display icon, you need to run the configuration setup Wizard. This is 
also the case after something has changed to the viewing station 
(e.g., a display was removed or added).
Running the configuration setup Wizard can be done by clicking on the 
Configuration Setup... button.
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• If an optical sensor has been used for executing a certain task, the last 
used sensor is depicted in the Configuration section.

• You can perform a number of  actions to the displays when they are 
listed in the Configuration section. Therefore, click with the right 
mouse button on the icon of the display you want to perform an 
action to. A menu with possible actions will pop up.

The menu contains the following items:

Properties Show the display and imaging board head 
properties and activate / deactivate some of 
the display’s features. 
In case of a sensor, show the sensor properties.

Add Display Add a display icon to the configuration. This 
action does not use the Configuration Setup 
Wizard, but allows you to directly add a Barco 
or non-Barco display.
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Remove Display Remove a display icon from the configuration.

Identify Check which imaging board head is connected 
to the selected display. The number of the head 
will appear on the selected display.

Presets Define targets for white level, black level and 
display function, and store them in a preset.

Calibrate Start display calibration immediately

Brightness/Contrast Control Contrast and Brightness manually or 
automatically, by means of Ambient Light Com-
pensation if present. The function is grayed if 
not available on the display.

Degauss Remove remaining magnetism from the dis-
play’s metal parts. Is only applicable to BARCO 
color  CRT displays.

Alignment Align display geometry, white uniformity, 
focus, etc. Is applicable to BARCO CRT displays 
only.

Luminance Uniformity 
Correction

Check this option to activate the Luminance 
Uniformity Correction.
This system, if calibrated by means of “Full 
Screen Calibration” (see below), ensures a uni-
form luminance, even in the corners of the pic-
ture tube.
This function is applicable to some BARCO dis-
plays only.
This function is grayed if the function is not 
available on the display.

Full Screen Calibration This function starts with a luminance measure-
ment in the center of the screen. It proceeds 
with calibration in a number of zones over the 
picture tube, to obtain the same luminance in 
each of the zones.
The function is applicable to some BARCO dis-
plays only.
The function is grayed if not available on the 
display.
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2 First Installation

2.1 Overview
If you install MediCal Pro on a medical viewing station for the first time, 
you should go through the steps listed below.

These steps are just listed here, as an overview of the complete 
installation. They are described in detail further in this chapter.

1 

Install the hardware components or check the installation of the 
hardware:
- Video connection
- Address setting (Barco CRT displays only)
- Data connection (Barco CRT displays only)
- Optical sensor connection (if applicable)
See § Installation of the hardware on page 21.

2
Install the MediCal Pro software. On Windows 2000 Professional and XP 
Professional: Restart the computer after installation.
See § MediCal Pro installation on page 23.

3
Start MediCal Pro
If appropriate, connect to MediCal Administrator.
See § Starting up for the first time on page 24.
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4
Set up the configuration
See § Setting up the configuration on page 29.

5

Align the displays, if necessary
See § Aligning the displays on page 44.

6

Define the presets
See § Defining Presets on page 52.
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7

Calibrate the displays. See § Calibrating displays on page 58.

8
Define the Q/A task schedule
See § Setting up the Q/A schedule on page 58.

9

Check the trigger settings for the different categories of Q/A tasks and 
change them if necessary
See § Defining the Q/A task trigger settings on page 59.

10
Run the due tasks
See § Running the due tasks on page 63.
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2.2 Installation of the hardware
MediCal Pro can be used on any viewing station that runs on Windows 
NT4, Windows 2000 Professional or Windows XP Professional. The 
viewing station can contain any number of displays, Barco and non-Barco 
displays.

It is impossible to describe the installation on all these systems in this 
manual, but we can give some important hints and rules to follow during 
the installation of the hardware.

For a detailed description of the installation, please refer to the system 
manual or display user manual.

Barco flat panel display installation

In case of a DVI connection: 

Connect the DVI cable of each display to a different imaging board head 
inside the viewing station’s computer.
The leftmost display must be connected to head A, the second leftmost 
display to head B, etc. 

You do not need to set the addresses of the flat panel displays.

Barco CRT display installation

1 Address setting: Each Barco display you wish to include in the 
configuration for Q/A checks must get a different remote address.
It is logical to assign address 1 to the leftmost display, 2 to the second 
leftmost display, etc.

Vid1

Vid2

COM port 

Remote In Remote In 

Remote Out 
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2 Video connection: Connect the video and sync inputs of each display 
to a different imaging board head inside the viewing station’s 
computer.
The leftmost display must be connected to head A, the second 
leftmost display to head B, etc.
Note: An imaging board can be a single-head or multi-head board. A 
multi-head board is as if several imaging boards were located on one 
single board, each with separate video and sync outputs. Each part of 
such a board is called a head.
E.g., a dual-head board contains two separate heads, and thus two 
separate video and sync outputs.

3 Data connection: 
You can control the Barco CRT displays through the USB bus or through 
serial connection.
Serial connection: Connect the displays’ Remote connectors in a loop-
through (daisy-chain) configuration to the viewing station’s computer. 
Connect Remote In of the leftmost display to one of the computer’s 
COM ports. Connect Remote Out of the leftmost display to Remote In 
of the second leftmost display, etc.
USB connection: Connect the USB upstream connector of the first 
display to the USB downstream connector on the PC. Connect the 
second display to the USB downstream connector on the first display 
etc.

Non-Barco display installation

Follow the Video connection guidelines described in the Barco display 
installation above. There is no Data connection nor address setting for 
non-Barco displays.

Optical sensor connection

Barco Coronis flat panel displays have a built-in optical sensor (I-Guard), 
for which no additional connection is required. For other Barco displays 
(e.g., Nio) and non-Barco displays you need to connect an external 
optical sensor.

The external optical sensor can be connected in two ways: 

• On Barco displays:
A USB sensor can be connected to one of the downstream USB ports 
on the display. In that case however, the display must be connected 
to the PC USB bus as well.
A serial sensor must be connected to the Sensor connector (front or 
rear). This is possible only on Barco CRT displays.

• Non-Barco displays don’t have a direct connection for the sensor. So if 
the viewing station contains non-Barco displays, connect the sensor to 
the viewing station’s computer. Connect it to a free COM or USB port.
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2.3 MediCal Pro installation
Minimum System requirements

• Operating system: Windows 2000 Professional/Windows XP 
Professional/Windows Server 2003 Standard Edition (32-bit)

• Memory: 128 MByte

• Free disk space: 50 MByte

• Internet Explorer 4.0 

Before installing MediCal Pro

1 You must have Administrator privileges to install the software.

2 Read the Release Note for the most recent information.

What if an earlier version of MediCal Pro is installed

• If MediCal Pro 2.02 or lower is installed, remove it before installing 
the new version. Please refer to the § “Uninstalling MediCal Pro”, 
further in this chapter.

• If MediCal Pro 2.03 or higher is installed, there is no need to uninstall 
it. Simply follow the guidelines below.

• Note: MediCal Pro 2.05 contains a new task for Barco Coronis displays: 
Auto Calibration. If you install V. 2.05 while a lower version is 
installed, you must manually add the new task. See “Adding tasks” on 
page 76. After this, make sure to check if the trigger settings for 
“transparent intervention-free” Q/A tasks are properly set. See § 
Defining the Q/A task trigger settings on page 59.

Installing MediCal Pro

To install MediCal Pro, enter Windows and follow these steps:

1 Exit all open programs.

2 Insert the CD-ROM containing the MediCal Pro installer program in the 
CD-ROM drive.

3 The CD-ROM starts automatically. After a few seconds, the MediCal Pro 
welcome window appears.

4 Click on Install. The Setup application starts.

5 Click on the Next> button.

6 Read the License agreement on the screen very carefully. Scroll down 
to read the complete text.

7 Click on Yes if you agree with the License agreement and wish to 
continue with the installation.

8 In the Customer information window, fill in the user name, company 
name, and serial number of MediCal Pro. You can find the serial 
number on the CD-ROM jewel case. Click on Next>.

9 A window appears, indicating the directory where MediCal Pro is 
going to be installed.
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Click on the Browse... button if you want to change this directory. Click 
on the Next> button to continue.

10 Choose the setup type that corresponds to the viewing station on 
which MediCal Pro is installed: A system with CRT displays or with flat 
panel displays.

11 Select the program folder where you wish to add the program icons.
Click on Next> to continue.

12 The installer program now starts to install the files at the appropriate 
place. 
The application MediCal Pro Startup is also installed. It is installed in 
the Startup folder. This application ensures the gamma is set properly 
when starting the system.

13 Please register the version of MediCal Pro. Therefore, click on Yes in 
the Register window.

If you have an Internet connection, you will be redirected 
automatically to a web page for registration. Please fill in the 
requested data and register.

14 Select Yes, I want to restart my computer now and click on Finish to 
complete the setup.

Uninstalling MediCal Pro

To remove MediCal Pro from your system, proceed as follows:

1 You must have Administrator privileges to uninstall the software.

2 Exit MediCal Pro.

3 From the Start menu, select Settings > Control Panel.

4 Double-click on the Add/Remove Programs icon.

5 Select MediCal Pro from the list box at the bottom of the Add/Remove 
Program Properties dialog.

6 Click on the Change/Remove... button.

7 Follow the instructions on the screen.

2.4 Starting up for the first time
MediCal Pro start-up

To start MediCal Pro, proceed as follows:

1 If the viewing station contains Barco displays, make sure there is no 
on-screen display (OSD) on the screen of the displays. Please refer to 
the display’s user manual to know how to do this.

2 Start MediCal Pro from the  Start > Programs > MediCal Pro menu in 
Windows.

3 If no license key was entered during installation, MediCal Pro prompts 
to enter the license key now. Enter a valid license number and click on 
OK.
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4 If the system contains no Barco flat panel displays, nor Barco CRT 
displays connected to the USB bus, MediCal Pro will notice that there 
is no configuration set up in the program yet. It will ask if you want to 
log in as Advanced user, to set up the configuration. 
Note: Barco Nio Fusion and Color Nio displays are not automatically 
detected at start-up. You should also add them by following the 
procedure described further.

5 If you select Yes, MediCal Pro opens the Log in window because you 
have to be advanced user to set up the configuration.

In the User Password box, enter “advanced”.

6 Select OK.

7 If the system contains Barco flat panel displays, the detected displays 
are mentioned in a message box.

Click on Add Now to proceed and add the displays to the 
configuration. Click on Cancel to proceed without adding the displays.

8 Choose whether or not you wish to connect to MediCal Administrator. 
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Note:
Prior to connecting the viewing station to the MediCal Administrator 
server, the medical facility to which the viewing station belongs, must 
be added already to MediCal Administrator. For more information, 
please consult your system administrator.
If you do not have MediCal Administrator installed on the network, 
select No and continue. Should Administrator be installed later, you 
can still connect to it from within MediCal Pro.
Please proceed with “Setting up the configuration” on page 29 .

If you have MediCal Administrator installed, select Yes to continue. 
MediCal Pro will start a Wizard to set up the server. Please proceed 
with “Connection to MediCal Administrator” on page 26.

Connection to MediCal Administrator

1 The Wizard starts with the Welcome page. To proceed with the 
connection, select Yes and click on  Next.

2 Enter the name of the network server on which MediCal Administrator 
runs. Click on Next.
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3 The Wizard will start searching for the server on the network. Click on 
Next to start the search.
If the Wizard does not find the server or if there are problems to 
register to the server, you will have to exit the Wizard. Contact the 
system administrator to solve the problem.

4 If the server is found, the Wizard displays the following message:
Click on Next.

5 The drop-down list shows all medical facilities connected to MediCal 
Administrator on the server.
If the facility to which this viewing station belongs, is not in the list, 
you should exit the Wizard by clicking on Cancel. The medical facility 
should be added from within MediCal Administrator.
If the facility is in the list, select it and click on Next.
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6 Enter the viewing station details: Workstation name, Department 
name, Room number and Floor.
Click on Next.

7 The entered information is added to MediCal Administrator. Click on 
Next.
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8 Click on Finish to go to the MediCal Pro main window.

2.5 Setting up the configuration
Introduction

The medical viewing station consists of a computer, a number of imaging 
boards (containing one or more heads), an optical sensor and one or 
more displays. They are all connected physically, by means of cables and 
connectors.
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An example of a medical viewing station consisting of one PC with four 
imaging board heads and four Barco flat panels connected. Those panels 
have an internal optical sensor.

The configuration is the logical representation of the viewing station’s 
components in MediCal Pro.

A complete configuration contains the following information:

• The number of imaging board heads inside the computer

• The imaging board properties

• The number of displays connected to the heads

• The properties of connected displays

• Whether or not a sensor is connected or built-in

• The properties of the sensor, if connected

This is the MediCal Pro  configuration corresponding to the medical viewing station shown above.

To run Q/A tasks on the viewing station or to perform actions on the 
viewing station displays, MediCal Pro must know the exact and complete 
configuration.

The first time MediCal Pro is run, the user must put the configuration into 
the program if the displays were not added to the configuration during 
startup. 

Setting up the configuration can be done easily using the Configuration 
Setup Wizard, which will guide you through the setup process.

An optical sensor built in or connected to the displays or viewing station, 
will be added to the configuration automatically when you start a task 
that requires a sensor.

Running the Configuration Setup Wizard

To start the Configuration Setup Wizard, click on the Configuration Setup... 
button in the main window. As a result, the Wizard starts.

The Wizard will guide you through the following steps:
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1 Configuration setup

This page indicates the start of the Wizard.

At the same time, a character appears on the screen of each display. It 
refers to the imaging board head the display is connected to. It will be 
visible during the complete setup process.

Click on Next to continue.

2 Barco displays

This page indicates the Wizard will start looking for connected Barco 
displays.

Click on the Next button to proceed.
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3 Searching for Barco displays

The Wizard looks if there are Barco displays connected to the workstation 
computer via serial data connection.

After a few seconds, it returns the number of found Barco displays. 

Note: In case Barco flat panel displays are connected to the workstation, 
the Wizard can identify the display serial numbers and the heads they are 
connected to.
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There are two possibilities:

4a The number of found Barco displays equals the number of imaging board 
heads in the viewing station

Click on Next to continue. Please continue with step 5.

4b The number of found Barco displays does not equal the number of imaging 
board heads in the viewing station

The Wizard asks if the number of found Barco displays really equals the 
number of Barco displays you want to add to the configuration.
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Yes:

You can proceed with the Wizard, adding Barco- and / or non-Barco 
displays. Continue with step 5.

No:

The Wizard gives a search error. 
Refer to “Solving Configuration Setup Wizard search errors” on page 40 
for more information about what to do in case of a search error.

Click on Next to continue.

5 Define Heads

Note: This step is skipped if only Barco flat panel displays have been 
found.

If the Wizard has found one or more Barco displays, it identifies the first 
one by communicating its serial number and by dimming the display’s 
screen a few times.

Add the display to the configuration by selecting the imaging board head 
it is connected to. This is the character in the white square in the lower 
right corner.

If you are not sure which head to select, click on Show this display. As a 
result, the display screen will be dimmed again. Select the head of which 
the character appears on the dimmed display.

Click on the Next button to add the next display. Repeat this until all 
Barco displays are added.

If you add Barco displays only, please continue with step 9.
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If you are adding non-Barco displays as well, please continue with the 
following step.

6 Control non-Barco displays

If there are more heads in the computer than found Barco displays or if 
no Barco displays were found at all, the Wizard asks if you want to add 
non-Barco displays to the configuration.

Yes:

You can proceed with the Wizard, defining the non-Barco displays.
Continue with step 7.

No:

The Wizard continues with only the Barco display(s) added. In case no 
Barco displays were added at all, the Wizard exits.
Continue with step 9.
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7 Remaining imaging board head

The Wizard allows to logically link a non-Barco display to each remaining 
imaging board head.

The Wizard makes a suggestion of the head to link the display to by 
inverting the colors of the character in the display’s lower right corner.

Select Yes if the display is really connected to this head (with video 
cables). Click on Next. The Wizard proceeds. 

Select No if you do not want to add the display to that head. 

Click on Next. The Wizard continues with only the Barco display(s) added. 
In case no Barco displays were added at all, the Wizard exits.
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8 Define display

Enter the brand name, type and serial number. Indicate if the display is a 
flat panel or CRT display. Also, you have to indicate whether the display is 
a grayscale display or not.
Note: It is important to enter the correct data here, so that the display can 
be found quickly should a task on this display generate an error in 
MediCal Administrator.

Click on Next to continue.

9 Display function

Select the display function you want to use for all the displays.
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Display function

Select the required display function from the drop-down list. For most 
medical viewing applications, we recommend you select the DICOM 
display function, as this function results in the most visible grayscales.

If you select Gamma, you can enter a display gamma value if the imaging 
board head, to which the display is connected, has an editable gamma 
table.
If you select Uncorrected, the program fills the imaging board gamma 
table with a linear function.

Ambient light compensation

Check this option if you want to compensate for the influence of the 
ambient light on the image. Especially when you have selected a DICOM 
or CIE display function, we advise to switch on this compensation to 
obtain a better display performance.

Glare compensation

Check Glare Compensation if you want to compensate for the influence of 
the bright parts on the dark parts of the image.
This option is always on (and grayed) if a DICOM display function is 
selected.

When finished, click on Next.

10 White and black luminance

You can choose to specify one particular white luminance and black 
luminance value for all the displays. 

Select Yes only if all displays are the same type and if you are sure about 
the value to specify. 

If you proceed in that case, the Define Luminance page appears.
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Enter the desired white and black luminance, expressed in cd/m² or fl, 
depending on the application settings.

11 Calibration

You can choose to calibrate the displays and possibly run a QA check on 
the displays after finishing the Wizard.

The Q/A check option can be checked only if the Calibrate option is 
checked.

We advise not to check either of these options at this time, because the 
displays have to be aligned (CRT displays only) after the configuration 
setup, and the presets still have to be defined or edited.

If you check one or both options, they will be executed after completion 
of the Wizard.
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12 Configuration setup complete

The Wizard is completed. Select Finish to return to the main window.
The display icons are now filled in in the main window’s Configuration 
section.

Note: If MediCal Pro was installed for CRT displays and the Wizard has 
now detected only Barco flat panel displays, a message appears, asking 
you to disable the Uniformity task for the flat panel displays. We advise to 
select Yes because the uniformity task is not needed for flat panels.

This message appears only if the Measure Uniformity task is loaded into 
the QA check schedule.

Now the Barco CRT displays must be aligned (if necessary), the presets 
must be defined, and the displays must be calibrated. Please proceed 
with the next chapter, “Aligning the displays”.

Solving Configuration Setup Wizard search errors

The Wizard returns a search error in case you make clear that the Wizard 
has not found all Barco displays that should be connected.
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The most common causes of failures in finding Barco displays are:

• Data cables not or wrongly connected

• Some of the displays have equal remote addresses.
The remote addresses can be set by means of the display’s OSD 
menus.

The Wizard provides two ways to solve a search problem, taking the 
above-mentioned possible causes into account.

Note:

The search error solving methods can work only for Barco CRT displays 
connected through a serial connection. For flat panel or non-Barco 
displays these methods are not applicable.

To solve a search error, proceed as follows:

a) The problem is probably caused by the data cables

This is the most common cause and the easiest one to examine. 
Therefore, we suggest you consider this option first.

Proceed as follows:

1 Check the hardware connection of data cables. Please refer to the 
Installation chapter to find out how the data cables should be 
connected.

2 Select Check the cables and search again.
Click on Next to continue.

3 The Wizard displays the Barco Displays page again. 
Click on Next to start a new search for Barco displays.
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The Wizard now continues with step 3 of the normal, previously described 
sequence. 

If the connection problem persists, the Wizard will arrive at the search 
error page again. If this is the case, the problem may be caused by 
overlapping remote addresses (ID’s).

b) The problem is probably caused by the remote ID’s

Proceed as follows:

1 In the Search error page, select Redefine the remote ID’s.
Click on Next to continue.

2 The Wizard indicates the maximum number of Barco displays you can 
add. This is the number of imaging board heads in the computer.
In the field, enter the total number of Barco displays you want to add. 
This number should not exceed the number given by the Wizard.
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3 The Wizard indicates it will start an interactive procedure to set the 
remote addresses correctly.

First, check if the data cables between the computer and all Barco 
displays are connected correctly.
When ready, click on Next to continue.

4 Unplug the Remote Out connection of the first display. When ready, 
click on Next.

5 Plug in the remote cable into the Remote Out connector of the first 
display again.

6 Unplug the Remote Out connection of the second last Barco display.
E.g., if 4 Barco displays are connected, you need to unplug the 
Remote Out connection of the 3rd one.
When ready, click on Next.
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7 You have to repeat the previous step on the other Barco displays, in 
descending order towards the computer.
Read and follow the instructions of the Wizard carefully.

8 After having disconnected each display one by one, reconnect all data 
cables.
Make sure they are connected properly!
Click on Next.

9 The Wizard makes a new search for Barco displays and continues with 
the normal configuration setup procedure as described above.

2.6 Aligning the displays
When the complete configuration is entered in MediCal Pro, you can align 
the displays, if necessary.

Barco CRT displays can be aligned from within MediCal Pro. You can align 
image geometry and (only for color displays) white uniformity.

Barco flat panel displays do not require any image alignment.

Non-Barco displays must be aligned using their own controls. Please refer 
to that display’s user documentation.

To start display alignment for Barco displays, right-click on the icon of the 
display you want to align. Select Alignment... from the drop-down menu.
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After a few seconds, the selected display shows a test pattern. At the 
same time, the display alignment dialog appears.  

The adjustments in the Alignment window are combined in a number of 
groups (display alignment families). 

Note:

The number of alignment families and alignments depends on the type of 
display you are about to install. On some display types, some of the 
above described alignments will not be present.

The possible display alignment families are:

Horizontal geometry settings

Vertical geometry settings
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East-West geometry settings

White uniformity settings (on color displays only)

Special settings

The Alignment dialog contains the following elements:

• The icons at the top of the dialog indicate the different alignment 
families (e.g., horizontal geometry, vertical geometry etc.).

• The second row of icons represents the different alignments that 
belong to the selected alignment family.

• The names of alignment families and alignments appear as screen 
tips when you move the mouse pointer over their icons.

• The slider under the icons allows you to perform the alignment. Drag 
the slider or click inside the slider bar. Click on the Reset button to 
undo the alignment.

• The text box under the slider indicates how to perform the alignment 
properly. Follow the instructions in this text box carefully.

• The Next>> button selects the following alignment. If you are not 
experienced in aligning the display, it is best to follow the sequence 
of alignments by using the Next>> button until you have performed 
all the alignments.

• The <<Back button selects the previous alignment.

• By clicking on the OK button, you exit the alignments. All changes are 
saved.

• By clicking on the Cancel button, you exit the alignments without 
saving any changes.
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Horizontal geometry settings

 Horizontal position (course)

Position the middle vertical line of the test image approximately in the 
center. This is a course adjustment. You will get the opportunity to fine-
tune later in the procedure.

 Screen width

Adjust the width of the white frame on the test image following the 
display’s specifications.  You will get the opportunity to fine-tune later in 
the procedure. Tip: It is a good idea to use a flexible plastic or paper ruler 
to measure the size.

 Horizontal linearity

Adjust until the distance between the vertical lines on the left side of the 
test image is the same as between those at the right. These lines are 
marked by arrows.

 Horizontal S-correction

Adjust until the distance between the vertical lines in the center of the 
test image is the same as between those at the left and the right.

 Horizontal blanking left

The background of the test image is highlighted (gray) and a white frame 
appears around the test image. When you drag the slider in the 
adjustment dialog to the right, a black vertical border appears at the left 
side of the test image. This is the blanking. Adjust now until this blanking 
stops at 0.5 cm (0.2 inch) before the left edge of the white frame. The 
frame must be completely visible.

 Horizontal blanking right

Now do the same at the right side of the test image. Adjust until the 
blanking starts at 0.5 cm (0.2 inch) after the right edge of the white 
frame . The frame must be completely visible.

 Rotation

Adjust until the white frame on the test image is perfectly upright.
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Vertical geometry settings

 Vertical position (course)

Position the middle horizontal line of the test image approximately in the 
center. This is a course adjustment. You will get the opportunity to fine-
tune later in the procedure.

 Screen height 

Adjust the height of the white frame on the test image following the 
display’s specifications. Tip: It is a good idea to use a flexible plastic or 
paper ruler to measure the size.

 Vertical linearity 

Adjust until the distance between the horizontal lines on the top of the 
test image is the same as between those at the bottom. These lines are 
marked by arrows.

 Vertical S-correction 

Adjust until the distance between the horizontal lines in the center of the 
test image is the same as between those at the top and the bottom.

  Top blanking, AKB shift and AKB removal

Proceed as follows:

1 Select the Top blanking adjustment. Adjust until the blanking (on the 
top of the test image) ends just above the top line of the white frame. 
This line must be completely visible.

2 Select the AKB removal adjustment. Drag the slider in the adjustment 
dialog completely to the left (0 adjustment).

3 Select the AKB shift adjustment. Drag the slider completely to the 
right (maximum adjustment).

4 On the test image, you can now see the so-called AKB and AWS lines. 
These are test lines for the internal circuits that guarantee the stability 
of the display’s white and black point. You should be able to see a 
bright ascending line (joined by two parts of gray lines) and two dim 
ascending lines, at a distance of a few cm. The bright line is the AWS 
line and the dim lines are AKB lines.

5 Step by step, decrease the AKB shift adjustment. As a result, the AWS 
and AKB lines in the test image move up. Adjust until the lowest AKB 
line has completely disappeared under the bezel and a bright 
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horizontal line appears under the bezel. This is the AWS line that is 
coming down again.

Note: If you are unable to shift the AKB lines high enough until they 
have completely disappeared, repeat the adjustment with a 
somewhat higher AKB removal value.

6 Select the AKB removal adjustment. Increase the adjustment until the 
line on top of the test image has completely disappeared.

East-West geometry settings

 Skewing

Adjust until the vertical lines in the middle of the test image are perfectly 
upright.

 Trapezoid deformation

Adjust until the vertical lines at the sides of the test image are upright as 
well.

 Parabola deformation 

Adjust until the vertical lines at the sides of the test image are as straight 
as possible.

 Corner deformation 

Adjust until the vertical lines in the corners of the test image are straight. 
As a result, the corners of the test image should be 90 degrees exactly.

 Bowing deformation 

Adjust until the vertical lines in the middle and at the sides of the test 
image are straight.

Note: You might have to repeat the east-west settings a couple of times 
to obtain a perfect result.

White uniformity settings (on color displays only)

The white uniformity adjustments compensate for the effect of disturbing 
magnetic fields on color displays. These magnetic fields cause color purity 
or white uniformity errors. The most common is distortion due to the 
earth magnetic field.
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 Vertical uniformity

This adjustment is especially necessary when the display is operating in 
the southern hemisphere or near the equator. Adjust to remove purity or 
uniformity errors, especially in the center of the image.

Note: After each change of vertical uniformity, you might notice the 
image gets a slight “shiver”. This is due to the degauss, which is done 
after each change in this setting.

 Axial uniformity

This adjustment compensates mostly around the edges of the image. As a 
side effect, the image rotates because of the adjustment. You can 
compensate this by means of the Rotation deviation adjustment 
(Horizontal geometry).

Special settings

 Astigmatism

Astigmatism adjustment influences the shape of the electron spot, where 
it hits the phosphors on the picture tube. Remark that an improper setting 
of astigmatism is interpreted by our eyes as bad focus.

Astigmatism must be adjusted separately in 25 zones on the screen. You 
must start with the center zone, followed by the zones around the center. 
The corners should be the last zones you adjust. We suggest the following 
sequence: 13-12-11-14-15-18-17-16-19-20-23-22-21-24-25-8-7-6-9-10-
3-2-1-4-5 (see illustration).
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To adjust the astigmatism:

1 In the adjustment dialog, select the zone you want to adjust by 
clicking on the corresponding number in the “Zone-selection” area. 
The corresponding zone of the test image is highlighted.

2 Gently drag the Static Focus slider completely to the right (maximum 
adjustment). The highlighted zone of the test image is completely out 
of focus. As a result, the lines of the test pattern have diverged, so 
that they now look like thick gray lines.

3 Adjust Axial Astigmatism until the horizontal and vertical lines of the 
test pattern have the same width.

4 Adjust Diagonal Astigmatism until the ascending and descending 
diagonal lines have the same width.

5 Pick the Static Focus slider and drag it approximately 1/3 of the slider 
bar length to the left. The lines of the pattern become narrower. Now 
repeat the Axial and Diagonal astigmatism adjustments.

6 Repeat step no. 5 two times more. The lines in the test pattern 
become smaller with each step. In this way, the adjustments become 
more and more accurate.

7 Click on the Reset button next to the Static Focus adjustment to bring 
the focus back again.

8 Proceed to the following zone until all 25 zones are completed.

 Focus

Focus can be adjusted separately in 9 zones. You must start with the 
center zone, followed by the zones around the center. The corners should 
be the last zones you adjust.

During focus adjustment, a text test pattern is displayed on the display 
you are adjusting. The pattern contains white text on a black background 
and black text on a white background. The best focus setting in each zone 
will be a compromise between the appearance of the white text and the 
appearance of the black text.

To adjust the focus:

1 In the adjustment dialog, select the zone you want to adjust by 
clicking on the corresponding number in the “Zone-selection” area. 
The test image appears in the corresponding zone.

2 One of both Focus adjustment sliders is active. Adjust until the focus is 
good for both text styles (white on black and black on white).

3 Proceed to the next zone until all 9 zones are completed.

 Astigmatism (fine adjustment)

As final step in the alignment, fine-tune the astigmatism in the 25 zones 
of the screen, using the black-on-white and white-on-black text pattern.
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2.7 Defining Presets
Introduction

For each display in the configuration, you must define a Preset.
The Preset is very important in the Q/A concept. In a preset you define 
the display’s reference for visual behavior. With this reference, we want 
the display to be conform. 

The Q/A tasks will use this reference to determine whether or not the 
displays are still performing OK.

A preset completely defines the display’s required visual behavior, based 
on essential parameters (see below). For each parameter you can enter a 
target value.

These parameters are:

White luminance: 

The required luminance for white parts of the image.

Black luminance: 

The required luminance for black parts of the image.

Display function:

The function that defines how the luminance evolves when the video 
signal goes from black to white.

For a color display, you must additionally define:

White chroma:

The chroma or color temperature for a white image.

Black chroma: 

The chroma or color temperature for a black image.

Moreover you can define in the Preset if glare compensation and ambient 
light compensation must be taken into account during calibration.

Note: For Barco Nio Fusion and Color Nio displays you cannot select a 
chroma setting. To change the display’s target chroma you must select a 
color temperature in the display’s built-in on-screen display (OSD). This 
function can be found in the Settings menu.

Procedure

To define the preset, right-click on the icon of the display of which you 
want to define the Preset. 
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Select Presets... from the drop-down menu.

The Presets dialog appears.

The left column shows the installed presets. The right window pane 
shows the properties of the preset selected in the left column.

You can select an installed preset and, if necessary, modify its properties. 

Alternatively, you can first copy the selected preset by clicking on the 
Copy button, and then modify its properties to create a new preset 
without overwriting one of the others.

Preset parameters

Name

Enter or edit the name of the preset selected from the left column.

White

These are the target values for the white luminance and chroma (color 
display only). Click the ... button to edit the values. 

The parameters for White are different for grayscale and color displays.
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White  target setup on grayscale displays

White target setup on color displays (screenshot taken from Barco Color Coronis displays)

Measure on next calibration

Select this option if you do not wish to enter a target value now. Instead, 
the target value will be determined by measuring during the next 
calibration.

Absolute value

Select this option if you wish to enter a numeric target value.
This option is preferred for Barco displays.

Luminance

In this field, enter the required target value.
The field will be grayed if the “Measure on next calibration” option is 
selected.

Maximized luminance (Barco Color Coronis displays only)

Select this option if you wish to obtain the highest possible luminance. As 
a result, the display will always be calibrated to the maximum luminance 
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the display can reach. This luminance will decrease in time and 
calibration will be needed more frequently.

On systems with multiple Color Coronis displays connected, MediCal Pro 
will ask to calibrate the other displays to maximized luminance as well, 
taking into account that the luminance on all these displays must be 
equal.

Maximized lifetime (Barco Color Coronis displays only)

Select this option if you wish to obtain the highest luminance setting that 
still guarantees the maximum lifetime of the display backlight. This 
luminance value also depends on the current color temperature.

Chroma (color displays only)

For displays in a Color Coronis system, you can select a predefined 
chroma from a drop-down list. 

If you select “User” from the drop-down list, you can enter the color 
temperature or chroma value for white in the Kelvin or xy fields.

On other types of color displays, the drop-down list is not present.

You can enter the required color temperature or chroma value for white 
in the Kelvin or xy fields.

Measure Now

Click on this button if you wish to measure the actual luminance and 
chroma (color displays only) values for white. You will be asked to 
calibrate the sensor (if necessary) and apply it to the screen.

Black

These are the target values for the black luminance and chroma (color 
display only). Click the ... button to edit the values. 

The parameters for Black are different for grayscale and color displays.

Black  target setup on grayscale displays
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Black target setup on color displays

Measure on next calibration (Luminance)

Select this option if you do not wish to enter a target value now. Instead, 
the target value will be determined by measuring during the next 
calibration.

Absolute value (Luminance)

Select this option if you wish to enter a numeric target value.
This option is preferred for Barco displays.

Luminance

In this field, enter the required target value.
The field will be grayed if the “Measure on next calibration” option is 
selected.

Measure on next calibration (Chroma - color displays only)

Select this option if you do not wish to enter a target value now. Instead, 
the target value will be determined by measuring during the next 
calibration.

Select this option if you wish to use the native LCD panel black chroma as 
chroma setting for black.

Same as white chroma (Chroma - color displays only)

Select this option in case you wish the black and white chroma values to 
be the same.
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Absolute value (Chroma - color displays only)

Select this option if you wish to enter a numeric target value.
This option is preferred for Barco displays.

Chroma (color displays only)

Enter the color temperature or chroma value for black in the Kelvin or xy 
fields.

These fields are available only if the “Absolute value” option for chroma 
is selected.

Measure Now

Click on this button if you wish to measure the actual luminance and 
chroma (color displays only) values for black. You will be asked to 
calibrate the sensor (if necessary) and apply it to the screen.

Tips for setting the White and Black parameters for color displays

This paragraph describes what parameters values you have to select for 
certain settings.

Constant chroma

If you wish to have a constant chroma setting, select the following 
parameter values:

• White Luminance: As desired

• White Chroma: As desired

• Black Luminance: Measure on next calibration

• Black Chroma: Same as white chroma

Constant chroma with maximized contrast ratio

If you wish to have a constant chroma with maximized contrast ratio 
setting, select the following parameter values:

• White Luminance: As desired

• White Chroma: As desired

• Black Luminance: Measure on next calibration

• Black Chroma: Measure on next calibration

Constant chroma means that all gray levels in the image will have the 
same chroma or color temperature.

Constant chroma with maximized contrast ratio means that  nearly all 
gray levels have the same chroma. Only the darkest gray levels will be 
darker to achieve a higher contrast ratio.
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Display function

Select the required display function from the drop-down list. For most 
medical viewing applications, we recommend you select the DICOM 
display function, as this function results in the most visible grayscales.

If you select Gamma, you can enter a display gamma value if the imaging 
board head, to which the display is connected, has an editable gamma 
table.

Dynamic Gamma is a gamma function that is shifted to take into account 
the non-zero luminance of an LCD panel when driven with a “black” 
signal.It results in more contrast in the darker image areas.

It is especially useful in CT applications to improve the perception of low 
Haunsfield values.
If you select Uncorrected, the program fills the imaging board gamma 
table with a linear function.

Ambient light compensation

Check this option if you want to compensate for the influence of the 
ambient light on the image. Especially when you have selected a DICOM 
or CIE display function, we advise to switch on this compensation to 
obtain a better display performance.

Glare compensation

Check Glare Compensation if you want to compensate for the influence of 
the bright parts on the dark parts of the image.
This option is always on (and grayed) if a DICOM display function is 
selected.

2.8 Calibrating displays
After defining the display’s Preset, the display is calibrated. This is 
described in detail in “Calibrating displays” on page 68.

2.9 Setting up the Q/A schedule
When every display in the configuration has the correct Preset values and 
is calibrated successfully, you need to set up the schedule of Q/A tasks 
that is appropriate for this viewing station.

To access MediCal Pro’s default Q/A schedule, click on the Q/A Setup... 
button in the main window. You can also add additional tasks if needed.  
For more information, please refer to “Setting up a Q/A task schedule” on 
page 74.

Note: Do not forget to check and, if necessary, change the trigger settings 
for the different Q/A task categories (see below).
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2.10 Defining the Q/A task trigger settings
The tasks can be categorized in three groups, depending on the impact 
they have on the user and the applications running on the viewing 
station.

The task categories are:

The trigger settings determine when the tasks will be executed after they 
have become due. 

You can define trigger settings for intervention-free and non-
intervention-free tasks.

It is not necessary to define trigger settings for transparent intervention-
free tasks, because they do not hinder the user when they are executed. 
So, these tasks can always start when they become due. They will start 
even when no user is logged in.

To define the task trigger settings:

1 From the Tools menu, select Options > Application Settings.

Transparent inter-
vention-free

The task runs completely in background. It does not 
require any action from the user and does not 
change the image on the display. E.g., an Automatic 
I-Guard Check on a BARCO Coronis display is such a 
task. 
These tasks can run also when no user is logged in 
on the workstation.

Intervention-free The task does not require any action from the user 
but does change the image on the display. E.g., the 
Measure Quality Level of a BARCO Coronis display 
runs completely automatic, but during the execution 
of the task, the current application image is replaced 
by test images necessary for the measurement.
These tasks can run only when a user is logged in on 
the workstation.

Non-intervention-
free

The task requires a user action. E.g., a visual check on 
a test pattern requires the user to confirm that the 
pattern was displayed correctly.
These tasks can run only when a user is logged in on 
the workstation. However, they will not run when a 
screen saver or DPMS is activated.
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2 Select the Trigger Settings tab.

3 Set the trigger settings.

The possible trigger settings are:
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When the user logs in

Tasks that have become due, will be executed at the moment a user logs 
in on the workstation.

This is a good setting for tasks that require a user interaction (non-
intervention-free). The tasks are executed after they have become due 
and at the moment someone logs in on the workstation. In that way you 
are sure a user is present to respond to the task's interactions.

When the screen saver is activated

Tasks that have become due, will be executed at the moment the screen 
saver is activated.

This is a good setting for tasks that can run automatically, but are not 
allowed to run while the workstation is occupied by a user (intervention-
free). The tasks are executed after they have become due and at the 
moment the screensaver pops up on the workstation. In that way you are 
sure no user is busy on the workstation when the task starts.

When the task becomes due

The tasks will be executed at the time they become due. This is the time 
entered in the Q/A Setup schedule. 

However, intervention-free and non-intervention-free tasks cannot run 
when no user is logged in. So, when no user is logged in at that moment, 
the task will not start. It will start the first moment someone logs in after 
the task has become due.

When you wish the tasks to start at the moment they become due, you 
have to select this trigger setting only.

Multiple trigger settings

When you check more than one trigger setting, the trigger conditions are 
handled in an OR-function.

Example:

Let us suppose you have checked the settings "When the user logs in" 
and "When the screen saver is activated" for the category of intervention-
free tasks. 

In that situation, the intervention-free tasks that have become due, will 
be executed at the moment someone logs in on the workstation or at the 
moment the screen saver pops up on that workstation, whichever occurs 
first.
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No trigger settings defined

If you do not check any of the trigger settings, the task will not start 
automatically, even when it has become due. The task can be run 
manually only.

2.11 When will a task start?
First condition: Task is due

The first condition for a task to start, is that it is or becomes due. In other 
words, a task will never start as long as it is not due.

The time that the task becomes due, is determined by defining the Q/A 
schedule.

Therefore, in the Q/A Setup, select frequency, time and (if appropriate) 
date you wish the task to become due.

Example: 

Let us suppose today is Wednesday, and the Automatic I-Guard Check 
task is scheduled weekly, on Thursday at 10 PM.

This means that tomorrow at 10 PM, the task will become due.

Will it also be executed at that time? That depends on the trigger settings.

Second condition: Trigger settings

Once a task is due, its execution depends on the Trigger settings.

In that way you can prevent that certain tasks would be executed while 
the workstation is occupied by a user.

Some tasks require a user interaction or temporarily replace the image by 
a test pattern. E.g., while the Measure Quality Level task is executed, the 
displays on which the task runs, are completely dimmed, apart from a 
white text being displayed.

In most cases, when you set up the task schedule, you cannot predict that 
the workstation will always be free when the task becomes due. Suppose 
that the Measure Quality Level task starts to run while a doctor is 
examining medical images. In that case, the doctor would not be able to 
continue viewing the images as long as the task is running.

To prevent situations like described above, you can set trigger settings. 
By setting trigger settings, you can prevent tasks to be executed at the 
time that they become due. They will be executed when they are due 
AND a certain condition (trigger setting) is true.
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Example:

Let us again suppose that the Measure Quality Level task is scheduled 
weekly, on Thursday at 10 PM.

Let us also suppose the trigger settings for this task are set to: "When the 
screen saver is activated".

On Thursday at 10.00 PM, a doctor is working on the workstation, viewing 
medical images. The task becomes due, because it was scheduled that 
way. However, the task does not start to run yet, because the screen 
saver is not activated.

At 10.45, the doctor stops, does not log off, and leaves the workstation. 
The workstation' s screen saver is set to wait 15 minutes. So, at 11.00 PM, 
the screen saver is activated. At that time, the task will start.

You cannot set trigger settings per task, but per category of tasks.

Third condition: If a user is logged in

Intervention-free tasks and non-intervention-free tasks (see task 
categories) will not start when no user is logged in, even if they are due 
and the trigger settings are true.

2.12 Running the due tasks
To complete the installation, it is important to run the due Q/A tasks for 
the first time. Therefore, click on the Q/A Check... button in the main 
window.

For more information, please refer to “Description of the tasks” on 
page 79.
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3 Using MediCal Pro

3.1 Starting up
To start MediCal Pro, proceed as follows:

1 If the viewing station contains Barco displays, make sure there is no 
on-screen display (OSD) on the screen of the displays. Please refer to 
the display’s user manual to know how to do this.

2 Start MediCal Pro from the Start > Programs > MediCal menu in 
Windows.

3 During start-up, the MediCal Pro Startup application may display the 
following message:

This means that another application has changed an imaging board’s 
Look-Up Tables since you have last used MediCal Pro. 
Select Yes if you want to restore the gamma to the value defined in 
MediCal Pro. This is the preferred choice if you were satisfied with the 
appearance of the images on the displays when you last closed 
MediCal Pro.
Select No if you do not want to restore the gamma defined in MediCal 
Pro. In that case, however, your display system will be no longer 
calibrated, because it was calibrated according to the gamma defined 
in MediCal Pro. 

4 During start-up, MediCal Pro may notice a change in the configuration 
(e.g., it cannot establish communication with one of the Barco 
displays in the configuration). 

Here is an example of a message that may appear when MediCal Pro 
has detected additional displays in the system:

Select Cancel to stop MediCal Pro.
Select Add now to continue with the start-up. 

Here is an example of a message that may appear when MediCal Pro 
has detected a display has been removed from the system:
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Select Quit application to stop MediCal Pro. Then you can try to restore 
the hardware connection to the display that was missing, and restart 
MediCal Pro.
Select Remove to continue with the start-up. 

5 Also during startup, the following message may appear:

This means a Q/A task is currently being performed. Please retry 
starting up a little later.

6 The MediCal Pro main window appears.

3.2 Entering Advanced user mode
To log in as advanced user

1 Press Alt-A on the keyboard or select Tools – Options – User Login... 
from the menus.
The User Login dialog appears.

2 In field User name, fill in your user name (maximum 20 characters).

3 In field User password, fill in advanced. This is the default password.

4 Click on OK.

To log out as advanced user and log in as standard user

1 In the Login dialog, fill in a user name different from the advanced 
user account (maximum 20 characters).

2 Do not fill in any user password.

3 Click on OK.
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3.3 Changing passwords

When you have logged in as advanced user, you can change the 
advanced user password.

To change the advanced user password:

1 From the main window, press Alt-A on the keyboard or select Tools – 
Options – User Login... from the menus. Your user name is still filled 
out in the User name field.

2 Click on Change Password.

3 In field Old password, fill in the current password.

4 In fields New password and Re-enter new password, fill in the new 
password.

5 Click on OK. The password is changed.

6 The Login dialog appears again. Click on Cancel to continue as 
advanced user, or log in as standard user.

3.4 Calibrating displays

 The calibration of the displays is a very important issue. Calibration is 
necessary to obtain conformance and to maintain consistency. It is 
inevitable during Configuration setup and may be necessary as 
intervention when a Q/A check turns out to be Not OK.

You can calibrate Barco displays and non-Barco displays, but the 
procedure for both categories is different.

MediCal Pro supports the following sensors for calibration: Barco LCD 
sensor, Barco Serial Sensor, X-Rite DTP92 (serial and USB), Wellhofer Luxor 
LXPlus, Solar PMA2200, Minolta LS100, Verilum CPOD (serial and USB) and 
Tektronix TJ17. Also the BARCO I-Guard sensor inside BARCO flat panel 
displays is supported.

Important:

The displays must be warmed up for at least 5 minutes before starting 
calibration.

To start calibration:

• Calibration starts automatically after defining a new, uncalibrated 
Preset or after modifying a Preset.
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• You can also calibrate a display by right-clicking on its icon in the main 
window, and selecting Calibrate... from the drop-down menu.

Calibrating Barco displays with built-in I-Guard sensor

The Barco Coronis flat panel displays have a built-in optical sensor that 
communicates with MediCal Pro.

The calibration runs completely automatically.

When the calibration is finished successfully, it displays the following 
message.

Click on OK to close the window.

Calibrating Barco displays with external sensor

Some Barco flat panel displays, like Nio and Nio Fusion, do not have an 
internal sensor and must be calibrated with an external sensor.

Proceed as follows:

1 For certain types of sensors, you may be asked to calibrate the sensor 
first.

Make sure the sensor is completely covered (so that no light can enter 
the sensor) and click on OK.

2 Put the sensor, with Ambient Light Shield if appropriate, on the image 
on the screen. 
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Important:
Make sure there are no application windows or other items (e.g., the 
cursor) displayed under the sensor. They would cause the calibration 
to fail.

When ready, click on OK.

3 For sensors that have an ambient light shielding only: If the Ambient 
Light Compensation option in the Preset is checked, the software asks 
you to remove the sensor from the screen and put it back without 
Ambient Light Shield.

When ready, click on OK.

After a few measurements, the software asks to remove the sensor 
once more, and put it back with the Ambient Light Shield.

4 When ready, click on OK.

5 When the calibration is finished successfully, it displays the following 
message.

Click on OK to close the window.
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Full screen calibration

Full screen calibration is possible on Barco CRT displays only. The optical 
sensor must be connected to the display to be able to perform full screen 
calibration.

The function is grayed if not available on the display.

The purpose of full screen calibration is to obtain a uniform luminance all 
over the screen. When full screen calibration is done, AND the option 
Luminance Uniformity Correction (see “Luminance Uniformity Correction 
on/off” on page 100) is switched ON, the luminance will be uniform all 
over the screen.

If the option Luminance Uniformity Correction is off, the result of the full 
screen calibration will not be visible on the screen.

To perform a full screen calibration:

1 In the Configuration section in the main window, right-click on the icon 
of the display on which you wish to perform full screen calibration.
From the drop-down menu, select Full Screen Calibration...

2 Put the sensor without Ambient Light Shield (for convenience) on the 
image and follow the instructions on the screen.

The full screen calibration starts with a measurement of luminance in the 
center of the screen. It proceeds with calibration in a number of zones 
over the picture tube so that the luminance in all of the zones equals the 
center luminance.
The zone where you have to put the sensor, is indicated by a white, 
blinking square.

Calibrating non-Barco displays

1 If you use an X-Rite DTP92 sensor, you may be asked to calibrate the 
sensor first.
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Make sure the sensor is completely covered (so that no light can enter 
the sensor) and click on OK.

2 Put the sensor, with Ambient Light Shield if appropriate, on the image 
on the screen.
Important:
Make sure there are no application windows or other items (e.g., the 
cursor) displayed under the sensor. They would cause the calibration 
to fail.

When ready, click on OK.

3 For sensors that have an ambient light shielding only: If you have 
specified an absolute value for black and white luminance in the 
Preset, and the Ambient Light Compensation option is checked, the 
software asks you to remove the sensor from the screen and put it 
back without Ambient Light Shield.

When ready, click on OK.

After a few measurements, the software asks to remove the sensor 
once more, and put it back with the Ambient Light Shield.

When ready, click on OK.
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4 The black luminance target value is determined now.

The sensor measures a black patch. The result of the measurement is 
shown in a small Measure window in the corner.

a) If you have specified an absolute value for black luminance in the 
Preset, MediCal Pro displays this value in the message.
You must control the display brightness manually until the 
measured value is equal or lower than the target value.

When this is the case, the OK button becomes active so that you can 
continue.

b) If you selected Measure on next calibration in the Preset, you 
must adjust display brightness manually, until a desired level of 
black luminance is attained.
When you click on OK, the measured value will be taken as black 
luminance target.

5 The white luminance target value is determined now.

The sensor measures a white patch. The result of the measurement is 
shown in the Measure window.

a) If you have specified an absolute value for white luminance in the 
Preset, MediCal Pro displays this value in the message.

You must control the display contrast manually until the measured 
value is equal or higher than the target value.

When this is the case, the OK button becomes active so that you 
can continue.

b) If you selected Measure on next calibration in the Preset, you 
must adjust display contrast manually, until a desired level of 
white luminance is attained.
When you click on OK, the measured value will be taken as white 
luminance target.
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6 The black luminance and white luminance measurements may 
influence each other, so that the value of the first step changes when 
the second step is done. Therefore, you have to repeat both steps 
(steps 3 and 4) until both values remain stable.

7 Click on Yes to repeat the measurements. Click on No if the values 
remain stable and you wish to proceed with the calibration.

8 For sensors that have an ambient light shielding only: If you selected 
Measure on next calibration in the Preset and the Ambient Light 
Compensation option is checked, the software asks you now to 
remove the sensor from the screen and put it back without Ambient 
Light Shield.
When ready, click on OK.

9 After a few measurements, the software asks to remove the sensor 
once more, and put it back with the Ambient Light Shield.
When ready, click on OK.

10 When the calibration is finished successfully, it displays the following 
message:

11 Click on OK to close the window.

3.5 Setting up a Q/A task schedule

The tasks can be categorized in three groups, depending on the impact 
they have on the user and the applications running on the viewing 
station.

The task categories are:
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To open the Q/A task setup window:

In the main window, click on the Q/A Setup... button. The Q/A Setup 
window appears.

When MediCal Pro is installed, a default task schedule is filled in.

The Q/A Setup window gives the following information:

Transparent inter-
vention-free

The task runs completely in background. It does not 
require any action from the user and does not 
change the image on the display. E.g., an Automatic 
I-Guard Check on a BARCO Coronis display is such a 
task. 
These tasks can run also when no user is logged in 
on the workstation.

Intervention-free The task does not require any action from the user 
but does change the image on the display. E.g., the 
Measure Quality Level of a BARCO Coronis display 
runs completely automatic, but during the execution 
of the task, the current application image is replaced 
by test images necessary for the measurement.
These tasks can run only when a user is logged in on 
the workstation.

Non-intervention-
free

The task requires a user action. E.g., a visual check on 
a test pattern requires the user to confirm that the 
pattern was displayed correctly.
These tasks can run only when a user is logged in on 
the workstation.

Task Name The task’s name or description

Status Whether the task is enabled or disabled

Schedule The frequency with which you wish the task to be exe-
cuted
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Adding tasks

By default, the task schedule contains a number of tasks. Other tasks are 
installed as plug-in. You can add them to the schedule in the following 
way:

1 From the Q/A task setup window, click on the Task Selector... button. 
The Add New Task window appears.

2 To get more information about a specific task, click on the name of the 
task and then click on the More Info button.

3 To add a task, click on the name of the task you wish to add and then 
click on the Add button.

4 When finished, click on the Close button.

Note:

There is no way to remove the tasks from the schedule. If you do not 
want a task to be executed, you have to disable it (see below).

Enabling or disabling tasks

To enable or disable a task:

1 In the Q/A setup window, right-click on the name of the task you wish 
to enable or disable. A drop-down menu appears.

Last Executed The date (in MM/DD/YY format) the task is last executed

Current status The result of the task’s last execution

Due Whether the task is due or not. This is determined by the 
task’s schedule and the moment it last has been exe-
cuted. E.g., a task that is scheduled daily, and that has 
been executed today already, will not be due until the 
next day. 
When you move the mouse cursor over the schedule, 
screen tips pop up to give you some detailed information 
about the schedule.
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2 Select Status > Disabled to disable the task. As a result, the task will 
not be executed until it is manually enabled again.
Select Status > Enabled to enable the task to be executed. The task 
will be executed according to the entered schedule. This is indicated 
by the check mark in the Due column.

Scheduling a task

To schedule a task:

1 In the Q/A setup window, right-click on the name of the task you wish 
to schedule. A drop-down menu appears (see above).

2 Select the desired frequency from the Schedule > menu: 

3 In the Select frequency window, select the time and, when 
appropriate, day and month you wish the task to be executed.

Daily The task becomes due every day at the scheduled time.

Weekly The task becomes due every week at the scheduled time.

Monthly The task becomes due every month at the scheduled 
time.

Quarterly The task becomes due every 3 months starting with the 
scheduled time.

Twice a Year The task becomes due every 6 months starting with the 
scheduled time.

Yearly The task becomes due every year at the scheduled time.
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Notes:

• After enabling and scheduling a task, it may still not appear as a due 
task. The cause of this may be that the display(s) in the configuration 
are not calibrated. Some tasks can be executed on calibrated displays 
only.

• The moment that the task will be executed automatically, depends on:

a) the moment it becomes due

b) the trigger settings for this category of tasks

c) if a user is logged in on the workstation

Checking and changing task properties

You can display the task properties and change some of them. 

There is a difference in properties between some of the tasks. Some of 
them even have no properties.

To display the task properties

1 In the Q/A setup window, right-click on the name of the task of which 
you wish to view the properties. A drop-down menu appears.

2 Select Properties... The task properties appear. The fields displayed in 
white can be edited by double-clicking on them.
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Description of the tasks

To display a task description

1 In the Q/A setup window, right-click on the name of the task of which 
you wish to view the description. A drop-down menu appears (see 
above).

2 Select Info... The task description appears.

3.6 Performing Q/A checks
Running Q/A tasks

MediCal Communicator service

During installation of MediCal Pro, a Windows service is installed as well. 
This service, called MediCal Communicator, will run the due tasks, taking 
the Q/A task time schedule and the task trigger settings into account.

The time schedule can be entered in the Q/A Setup window. See “Setting 
up a Q/A task schedule” on page 74.

The task trigger settings can be entered in the Application Settings menu. 
See “Defining the Q/A task trigger settings” on page 59.

Before the tasks can be executed, MediCal Pro must be closed.

When an intervention-free or a non-intervention-free task starts, MediCal 
Communicator will display a message saying a task is ready to be 
executed.

When you wish the task(s) to be executed, click on OK.

When you do not wish the task(s) to be executed, click on Cancel.

When the user does not respond to the message, after some time the 
task will be executed automatically.

Running tasks from within MediCal Pro

Running all due tasks

To run all today’s due tasks from within MediCal Pro, first start up MediCal 
Pro (see “Starting up for the first time” on page 24).
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To run the due tasks, click on the Q/A Check... button in the main window.

A window appears, displaying the due tasks for today. 

Click on Yes to run the tasks immediately.

All due tasks will be executed in the order they appear in MediCal Pro’s 
Q/A Setup window.

Click on No to skip the execution of the tasks. The tasks’ result will be 
indicated as Skipped but the tasks remain due. They will be run the next 
time you perform a Q/A Check.

Running a single task

At any time, you can run any task, even if it is disabled or not due.

To run a single task:

1 In the main window, click on Q/A Setup...

2 In the Q/A setup window, right-click on the name of the task you wish 
to run. A drop-down menu appears.
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3 Select Run Now. The task will start immediately.

Checking task results

Checking the results of executed tasks can be done with the MediCal 
Administrator application, if installed.

However, also in MediCal Pro you can check the task results.

To check the task results, click on the Q/A Setup... button in the main 
window.

To troubleshoot tasks that are Not OK

Tasks that were Not OK the last time they were executed, are indicated 

with a question mark  in the Current Status field in the Q/A Setup 
window.
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• To see a description of the problem(s), click on the question mark. The 
problem description appears.

• To get hints for a possible solution, click on the sentence See here how 
to solve this problem. As a result, an html page with problem solving 
hints appears.

To display all tasks’ last results

To display all tasks’ last results, click on the Last Result Logs... in the Q/A 
Setup window.

The overview of all tasks’ last results appears.
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• To see the history log of a task, click the task name in the All Results 
window.

• For tasks that were Not OK: To see a problem description and a hint to 

solve the problem, click on the question mark  next to the task in 
the All Results window.

To display a particular task’s last result

To display a particular task’s last result, right-click on the task name and 
select Last Result Log... from the drop-down menu.

The tasks’ last result appears.

• To see the history log of a task, click the task name in the Last Result 
window.
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• For tasks that were Not OK: To see a problem description and a hint to 

solve the problem, click on the question mark  next to the task in 
the Last Result window.

To display a particular task’s history of results:

In the Last Result window (see above), click on the underlined name of 
the task.

The history is displayed in table or graph form, and can be printed out. 
Exception: For Test pattern tasks, graph form nor printing can be selected.

  Graph form

 Table form

Alternatively, in the Q/A Setup window, right-click on the task name and 
select History... from the drop-down menu. The history is shown as table 
only, and cannot be printed.
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To see more (older) results in the history list, click on the double arrow 
under the scroll bar at the right of the list.

To define the number of results you want to see in the history list, click on 
the small square under the scroll bar at the right of the list, and select the 
number of results by moving the slider in the Select number of results 
dialog box.

To display details about one of the results

To display details about one of the results, select a result in the Task 
History window (see above) and click on the Details button.

Using test patterns for a quick Q/A check

You can perform a quick Q/A check by displaying a test pattern on the 
viewing station displays and checking the picture quality.

To display a test pattern:

1 In the Configuration section in the main window, select the display on 
which you wish to see the test pattern. You can do this by clicking on 
its icon.
If you have logged on as Guest user, you cannot select a display. The 
test pattern will be shown on the first display.

2 Click on the Test Patterns... button. The Test Patterns dialog appears.
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3 Select a pattern from the drop-down list.
If you select Select Image, a dialog box will appear when the pattern 
is loaded, allowing you to select any jpg, bmp or gif image file on the 
computer.

4 Click on the Load button.
After a few seconds, the test pattern will appear.

5 The following patterns provide a Measure window, allowing you to 
measure certain areas from the test pattern with the optical sensor:

a) Centered square

b) Select Image

c) Uniformity

6 Right-click on the test pattern to display a menu with the following 
options (depending on the configuration and pattern, some of them 
may not be available):

Test pattern description

The default test patterns are:

Invert LUT: Invert the values in the imaging board’s LUTs (white 
becomes black, black becomes white, etc.)

Linearize LUT: The LUT entries are filled with a linear function (a 
gamma of 1).

Full Screen: Expand the test pattern over the connected displays, 
covering the full virtual desktop.

Every Screen: Repeat the test pattern on every connected display.

Quit: Close the test pattern.

Pattern name Description

Astigmatism This pattern can be used to check the astigmatism 
and overall focus of the display. Check that the pat-
tern is displayed sharp all over the screen.
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Bands with text This pattern can be used to check if the display func-
tion is perceptually linear (calibrated according to the 
DICOM display curve).
This is the case if the text in all of the bands is legi-
ble.

Briggs This pattern can be used to check if the display func-
tion is perceptually linear (calibrated according to the 
DICOM display curve). The pattern consists of rectan-
gles including small squares that are 5% darker.
The small squares in each of the rectangles should be 
visible if the system is calibrated according to the 
DICOM display function.

Centered Square This pattern can be used to check the white lumi-
nance.
Put the optical sensor on the white square and check 
the measured luminance displayed in the measure-
ment window

Characters This pattern can be used to check the image focus.
Check that the characters are sharp.

Contrast & noise This pattern can be used to check the video signal.
Check that there is no ghosting or smearing near the 
white squares.

Focus Just like the Characters pattern, this pattern can be 
used to check the image focus.
Check that the characters are sharp.

Grid This pattern can be used to check the image geome-
try (size, position, linearity) and focus.
Check if the lines of the pattern are:
- straight
- at an equal distance apart 
- sharp

Horizontal gradientThis pattern displays a horizontal gradient from black 
to white. You can use this pattern to check the gray-
scale performance.

SMPTE The SMPTE pattern is a universal pattern with which 
you can check geometry, focus, white luminance, 
bandwidth and display curve.
We suggest to check on display curve. Therefore, 
check the patches with the 5% gray square on black 
and the 95% white square on white. The gray 
squares should be visible if the system is calibrated 
according to the DICOM display function.
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3.7 Changing an existing configuration

 When a configuration is set up, you can add or remove displays 
without running the Configuration Setup Wizard.

Note:

After changing anything to the configuration, you need to run the Q/A 
tasks again. If not, the task results will appear Unknown.

Adding a display

If the main window displays an imaging board head without an added 
display (represented by a square without display icon), you can add a 
display to the head.

To add a display:

1 Right-click on the imaging board head icon and select Add Display... 
from the drop-down menu.

Select image Browse and select your own test pattern. MediCal Pro 
supports bmp,  jpg and gif files.

TG18QC This pattern is a universal pattern with which you can 
check geometry, focus, white luminance, bandwidth 
and display curve, according to the AAPM qualifica-
tions.

Uniformity This pattern can be used to check if the white and 
black levels are uniform all over the screen. There-
fore, put the sensor on the different patches on the 
screen, and check the Measure window to see if the 
measured value is approximately the same all over 
the screen.

Wedge This pattern shows three different white-to-black gra-
dients. You can use it to check the grayscale perfor-
mance and bandwidth.
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2 Barco flat panel displays are added immediately. For all other display 
types, the Display Connection Setup dialog appears.

a) Select the USB tab if you want to add a Barco display (flat panel or 
CRT) connected to the USB bus. 

• From the drop-down list, select the serial number of the display 
connected to this head.

• Click on Identify to see which display is connected to which head. 
For a few seconds, you will see the letter of the heads on the displays. 
They automatically disappear after a few seconds.

• Click on Show display to see which display corresponds to the serial 
number chosen from the drop-down list.
The image of the selected display will blink for a few times.

b) Select the Serial port tab if you want to add a Barco CRT display 
connected to the serial (Remote) bus. 
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• Check the communication port to which the display is connected.

• Select the Remote Address number corresponding to the display’s 
remote address.

• Click on Identify to see which display is connected to which head. 
For a few seconds, you will see the letter of the heads on the displays. 
They automatically disappear after a few seconds.

• Click on Show display to see which display corresponds to the Remote 
Address chosen from the drop-down list.
The image of the selected display will blink for a few times.

c) Select the No Link tab if you want to add a non-Barco display.

Enter the brand name, type and serial number. Also, you have to 
indicate whether the display is a grayscale display or not, and a CRT or 
flat panel display.

Note: It is important to enter the correct data here, so that the display 
can be found quickly should a task on this display generate an error in 
MediCal Administrator.

Removing a display

To remove a display, right-click on the display icon and select Remove 
Display... from the drop-down menu.

The display is removed immediately.
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Note:

When a display is removed from the configuration, the task histories 
related to that display will no longer be visible in MediCal Pro.

However, the histories are not deleted. When you connect the same 
display again, the histories will be visible as well.

3.8 Connecting to MediCal Administrator

 When MediCal Pro starts up for the very first time, it provides the 
opportunity to connect to a server on which MediCal Administrator is 
installed. If MediCal Pro is not yet connected to a MediCal Administrator 
server, it is still possible to do this in the program.

Note:

Prior to connecting the viewing station to the MediCal Administrator 
server, the medical facility to which the viewing station belongs, must be 
added already to MediCal Administrator. For more information, please 
consult your system administrator.

To connect to MediCal Administrator:

1 From the Tools menu, select Administrator Connection.

2 The MediCal Administrator Connection Wizard starts. Please refer to 
the chapter “First Installation” for a detailed description of this Wizard.

3.9 Registering the operations in a log file

 MediCal Pro stores the results of the Q/A checks in a log file, and if it 
is connected to a MediCal Administrator server, it sends the result data to 
MediCal Administrator.

Apart from these methods of logging, MediCal Pro can keep track of all 
the operations the users perform in the program.

This file, called log, is stored on the hard disk in the MediCal Pro program 
folder. It can be opened with any text editor.

This registration can be switched on or off.

To select / deselect logging:

1 From the Tools menu, select Options > Application Settings.
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2 Select the General tab.

3 If Logging is checked, the manipulations are registered in the log file.
If Extended Logging is checked, more data are registered in the log 
file. However, selecting this option will slow down MediCal Pro.

Example of a Log file
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3.10 Selecting Luminance units

 The results and values of luminance measurements can be expressed 
in Candela per square meter (Cd/m²) or Footlambert (fL).

To select the luminance units:

1 From the Tools menu, select Options > Application Settings (see 
above).

2 Select the General tab (see above).

3 Select the desired luminance unit.

3.11 Selecting units of length

 In the Display properties, you can enter the screen size of the displays. 
You can do this in inches or millimeters. You can select this unit of length 
in the Application Settings dialog.

To select the units of length:

1 From the Tools menu, select Options > Application Settings (see 
above).

2 Select the General tab (see above).

3 Select the desired unit of length.

3.12 Setting up optical sensor list and priority

 MediCal Pro supports a list of possible optical sensors. To speed up the 
search for connected optical sensors, it is best to indicate which sensor 
types are used and which ones are not used. 

Moreover, you can set up a priority of sensors. This may be necessary 
when using Barco flat panel displays with built-in I-Guard sensor. When 
you wish to use an external sensor for measurements on the flat panel, 
you should assign it a higher priority than the I-Guard sensor. In that case, 
MediCal Pro will automatically select the external sensor for the 
measurements.

To set up the list and priority of used sensors:

1 From the Tools menu, select Options > Application Settings (see 
above).

2 Select the Sensor Setup tab.
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3 Check the types of sensors used on the viewing station. Do not check 
the types that are not used.

4 Select a sensor type and use the and buttons left of the 
sensor list to change the priority of sensors. 

3.13 Additional display functions
Viewing display and imaging board properties

 In the Configuration section in the main window, right-click on the 
icon of the display you wish to view the properties of.

From the drop-down menu that appears, select Properties...
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The display device properties dialog appears.

Display Properties

Select the Display tab in the display device properties dialog.

Brand name: The display brand name.

Display type: The display type or description.

Serial number: The display’s serial number.

Software number: The order number of the display’s internal software 
(BARCO displays only).

Screen height The height of the visible display screen. The unit of 
length can be selected in the Application Settings 
dialog.
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Display Details: Flat panel displays

Screen width The width of the visible display screen. The unit of 
length can be selected in the Application Settings 
dialog.

Gray scale: This option is checked if the software has detected 
the display is a grayscale display (BARCO displays 
only) or if the user has defined the display as a gray-
scale display during the configuration setup.

CRT/Flat panel: Whether the display is a CRT or flat panel type.

Details: (BARCO displays only) Click to get additional informa-
tion about the display and activate / deactivate some 
additional features (see below).

Display Number The order number of the display

Software Number The order number of the display’s internal soft-
ware (BARCO displays only)

Lifetime The time (in hours) the display has been operat-
ing so far, including the time the display was 
switched in power-saving mode (BARCO displays 
only)

Runtime The time (in hours) the display has been operat-
ing so far, excluding the time the display was 
switched in power-saving mode (BARCO displays 
only)
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Display Details: CRT displays

Stabilizer Check this option to switch on the backlight sta-
bilizer. The option is grayed if not applicable to 
the selected display.

DPMS Check this option to switch on the Power Saving 
utility (DPMS). The option is grayed if not appli-
cable to the selected display.

Power LED Check this option to switch on or off the func-
tionality of the power LED.

Per Pixel Uniformity This option is available for Barco displays of type 
MFGD 5621 HD only.
When switched on, the Per Pixel Uniformity sys-
tem is activated, adjusting the luminance output 
at pixel level and eliminating screen noise.
See also “Special functions for displays in mam-
mography systems” on page 102.

Show Pixel Defects This option is available for Barco displays of type 
MFGD 5621 HD only.
This function indicates the location of the defect 
pixels on the LCD panel
See also “Special functions for displays in mam-
mography systems” on page 102.
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Info

Miscellaneous

Imaging board properties

Display Number The order number of the display

Software Number The order number of the display’s internal software 
(BARCO displays only)

Software version The version of the display’s internal software (BARCO 
displays only)

Lifetime The time (in hours) the display has been operating so 
far (BARCO displays only)

Scan Mode The scan mode, internally selected from the display’s 
memory (BARCO displays only)

Orbiter Check this option to switch on the Orbiter. The option 
is grayed if not applicable to the selected display.

Powersave Check this option to switch on the Power Saving util-
ity (DPMS). The option is grayed if not applicable to 
the selected display.

Remote Address The internal address of the selected display (BARCO 
displays only). Each display connected to the same 
computer must have a different address. 
The addresses must be set with the display’s internal 
controls.

Remote Timeout The time after which the display interrupts communi-
cation with the computer should the computer not 
respond anymore (e.g., is “crashed”).
Applicable to BARCO displays only.
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Select the Imaging board tab in the display device properties dialog.

Controlling Contrast & Brightness

 This function is available for BARCO CRT displays only.

In the Configuration section in the main window, right-click on the icon of 
the display you wish to control contrast or brightness of.

From the drop-down menu that appears, select Brightness/Contrast...

The Brightness/Contrast control panel appears.

Type The type or brand of the board

Serial number The imaging board serial number

Resolution The resolution of the imaging board head

Gamma table Whether the board contains an editable gamma table 
or not

Color depth The gamma table’s color depth. This number deter-
mines the number of grayscales or colors that can be 
reproduced

No. of entries The number of entries in the gamma table

Firmware version The on-board firmware version

Driver version The driver version controlling the board
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Automatic Contrast / Brightness

If checked, this function uses the Ambient Light Compensation option to 
control Contrast and Brightness automatically.

In that case, the Contrast and Brightness will be set depending on the 
ambient light around the display.

This function is grayed if the Ambient Light Compensation option is not 
installed in the display.

Contrast & Brightness sliders

If Automatic Contrast / Brightness is not checked, you can control Contrast 
& Brightness manually by moving the sliders.

Brightness control affects all the luminance levels of the image, from the 
dark background to the peak white parts of the image.

Contrast control does not change the background and darkest parts. It 
changes the difference in luminance between the background and the 
lighter parts of the image.

Clicking on the Contrast (Brightness) icon left of the sliders, puts the 
Contrast (Brightness) control in calibrated position. This is the preferred 
position.

Luminance Uniformity Correction on/off

 This function is available for BARCO displays only.

In the Configuration section in the main window, right-click on the icon of 
the display of which you wish to switch LUC on or off.
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From the drop-down menu that appears, select Luminance Uniformity 
Correction...

The Luminance Uniformity Correction system, if calibrated by means of 
“Full Screen Calibration” (see below), ensures a uniform luminance, even 
in the corners of the picture tube. 

This function is grayed if the function is not available on the display.

Full Screen Calibration

 This function starts with a normal calibration in the center of the 
screen. It proceeds with calibration in a number of zones over the picture 
tube.

Please refer to “Full screen calibration” on page 71 for more information.
The function is grayed if not available on the display.

Degaussing displays

 This function is available for color CRT BARCO displays only.

In the Configuration section in the main window, right-click on the icon of 
the display you wish to degauss.

From the drop-down menu that appears, select Degauss.
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As a result, possible purity errors in the image (so-called hot spots) are 
removed. The display automatically degausses at switch-on.

3.14 Special functions for displays in mammography systems

 These functions are available for Barco displays of type MFGD 5621 HD 
only.

To get access to the special functions:

1 In the Configuration section in the main window, right-click on the icon 
of the display you wish to view the properties of.

2 From the drop-down menu that appears, select Properties...

3 Select the Display tab in the display device properties dialog.

4 Click on Details...

5 The display details window appears.

Per Pixel Uniformity

For mammography viewing applications we recommend switching Per 
Pixel Uniformity (PPU) on.

When switched on, the Per Pixel Uniformity system is activated, adjusting 
the luminance output at the pixel level and eliminating screen noise. 
If you wish to activate PPU, check the Per Pixel Uniformity check box. To 
de-activate PPU, uncheck the Per Pixel Uniformity check box.

Show Pixel Defects

Click this button to get a graphical overview of pixel artifacts and 
microblemishes on the LCD panel.
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When clicking on Show Pixel Defects, a map with all pixel artifacts 
appears on the screen. Each artifact is indicated by a symbol.

• A black circle indicates a partly bright subpixel.

• A white square indicates a dark or partly dark subpixel.

To get more information about a single pixel artifact, move your mouse 
over the corresponding symbol. Additional pixel information appears as 
tooltip.

To show the map of microblemishes, right-click on the pixel defects map 
and select “Show microblemishes” from the menu.

As a result, a map with all microblemishes appears.

Information: 

An LCD screen consists of many liquid crystal pixels. Each pixel contains 3 
subpixels and each subpixel is made up of multiple domains.

It is inevitable that an LCD panel may exhibit a number of pixel artifacts: 
one or more domains may be dark or bright. This is clearly defined in the 
LCD panel specification. MediCal Pro can clearly show where the artifacts 
are located so that the user can distinguish the difference between a pixel 
artifact and an important issue in the diagnostic image.

A microblemish is smaller than a defect subpixel. Most likely, 
microblemishes are dust particles within the LCD panel.

List Pixel Defects

When clicking on List Pixel Defects, a report in PDF format appears.

The PDF file gives an overview of the pixel artifacts and microblemishes. 
You can print this file.

3.15 Changing the program’s appearance

It is possible to change the appearance of MediCal Pro somewhat. The 
change in appearance affects the size of characters and icons used in the 
program.

Changing the appearance might be necessary to improve the legibility 
when the displays are switched to a different resolution.

To change the appearance:

1 From the View menu, select Select Style.

2 Select the desired style, from “Smallest” to “Extra Large”.



Using MediCal Pro 104

The change in appearance is activated after restarting MediCal Pro.

3.16 Getting help
Context-sensitive help

MediCal Pro contains context-sensitive help. To get help about a particular 
view or window, press F1 on the computer keyboard. As a result, the 
online help pages will open at the desired help page.

Help menu

The Help menu contains the following items:

Help Open the online help pages

Send Feedback After selecting this option, you can enter your e-mail 
address and mail server name, if you have not 
entered them before. MediCal Pro now creates the 
file MedicalLogs.zip in the application directory and 
attaches it to the e-mail. 

If the automatic e-mail creation fails, please try send-
ing the MedicalLogs.zip file, together with a detailed 
problem description, to mis.support@barco.com , 
using your standard mail application.

Note: If you don’t know the exact data to fill out the 
Send Feedback dialog, you can always look for the 
MedicalLogs.zip file in the MediCal application direc-
tory, and just mail them to mis.support@barco.com, 
without using the Send Feedback function.

About Displays the details of this version of MediCal Pro.

mailto:mis.support@barco.com
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GLOSSARY
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4 Glossary

Q/A check

In softcopy diagnostic systems, displays are used to judge medical 
images and to take conclusions about patients’ physical condition.
It is obvious that the image quality is of the utmost importance. 
Therefore it is necessary to check the quality of the system, and 
especially the displays’ image quality, on a regular basis.
A Q/A check tests the image quality of all the displays on a medical 
viewing station. It consists of a number of Q/A tasks.
Some Q/A tasks have target values and tolerances that can be set 
to generate a warning or an error. For other tasks, the user must 
judge if the result is OK or not.
When an error occurs, measures must be taken immediately to 
restore the image quality.
In the intervention-free concept of MediCal, tasks can be 
scheduled to start automatically, running in background. Some of 
the tasks do not require any user interaction at all. The tasks are 
executed and the results are immediately sent to MediCal 
Administrator, if installed.

Conformance (conformity)

When the system is installed, a Preset is defined for each display 
in the viewing station. This Preset is the reference for the display’s 
visual behavior. When the display image quality is good, the 
display is conform to the defined Preset.

Consistency

Due to aging and other external conditions, the display image 
quality is not constant. If the change in image quality is still within 
the tolerances defined in the task properties, the display is still 
consistent.

Calibration

In many cases, calibration is the remedy for a display that is no 
longer conform to its Preset.
The calibration routine restores the black luminance, the white 
luminance and the display function. 
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Viewing station

The medical viewing station consists of a computer, a number of 
imaging boards (containing one or more heads), an optical sensor 
and one or more displays. They are all connected physically, by 
means of cables and connectors.

Configuration

The configuration in MediCal Pro is the software representation of 
the viewing station’s hardware components.
A complete configuration contains the following information:

• - The number of imaging board heads inside the computer

• - The imaging board properties

• - The number of displays connected to the heads

• - The properties of connected displays

• - Whether or not a sensor is connected or built-in

• - The properties of the sensor, if present

Display Function

A Display Function describes how a display device converts the 
voltages at the inputs into light. 
In the context of a medical viewing station, a display device is the 
combination of imaging board and display.
The display function is a graph that shows how the light from the 
picture tube evolves from minimum to maximum luminance while 
the data levels at the input of the imaging board go from 0 to 
maximum.

Gamma

The Gamma function is a kind of display function, characterizing an 
apparatus that converts voltages into light or ink or vice versa. 
Displays, printers, scanners, ... all have their own, unique Gamma 
function.
In a display, this function is exponential. The Gamma value is the 
exponent that determines the shape of the function.

Imaging board head

An imaging board or graphics board converts the digital data from 
the computer into analog video voltages.
Most of the common imaging boards contain just one set of video 
and sync outputs. However, some high-end boards, like some of 
the BarcoMed boards, contain two sets of video and sync outputs. 
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This is called a dual head  imaging board. It is like two complete 
imaging boards implemented on one single unit.
A dual head board in the computer behaves exactly as if two 
separate boards were installed.

DICOM

DICOM stands for Digital Imaging and Communications in 
Medicine. It is a standard developed by the American College of 
Radiology (ACR) and the National Electrical Manufacturers 
Association (NEMA). 
The standard specifies how digital image data can be moved from 
system to system. 
In addition, Supplement 28 Part 14 specifies a function that relates 
pixel values to displayed Luminance levels and is called Grayscale 
Display Function Standard.



109

Index

Symbols
(Advanced user symbol) 10

A
Add Barco display 89
Add Display 15, 88
Address 21, 42, 98
Advanced user 25
Advanced user mode 10, 13
AKB removal 48
AKB shift 48
Alignment 16, 44
Ambient Light Compensation 38, 58, 70, 72, 100
Ambient Light Shield 69, 71, 72
Automatic Contrast / Brightness 100
Axial uniformity 50

B
Black chroma 56
Black luminance 52, 73
Black point 48
Bowing deformation 49
Brightness 16

C
Calibration 16, 39
Candela 93
Cd/m² 93
Chroma 55, 56
Configuration 14, 25

Has changed 66
Configuration Setup 14
Conformance 10



110

Consistency 10
Contrast 16
Corner deformation 49

D
Daily 77
Data connection 22, 41
Defect pixel 102
Degauss 16
Display alignment 44
Display Details 96, 97
Display device 107
Display function 37, 38, 52, 58
Display Properties 95

E
Every Screen 86

F
FL 93
Flat panel display 11, 24, 25, 32, 34, 40, 44, 68, 90, 93, 96
Footlambert 93
Full Screen 86
Full screen calibration 16, 101

G
Gamma 24

Has changed 66
Gamma Initializer 23, 66
Glare compensation 38, 58

H
Help 104
Horizontal blanking left 47
Horizontal blanking right 47



111

Horizontal linearity 47
Horizontal position 47
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